Thermo Fisher Scientific is registered with B2B Compliance (B2Bcompliance.org.uk) in the UK and with the European Recycling Platform (ERP-recycling.org) in all other countries of the European Union and in Norway.

If this product is located in Europe and you want to participate in the Thermo Fisher Scientific Business-to-Business (B2B) Recycling Program, send an email request to weee.recycle@thermofisher.com with the following information:

- WEEE product class
- Name of the manufacturer or distributor (where you purchased the product)
- Number of product pieces, and the estimated total weight and volume
- Pick-up address and contact person (include contact information)
- Appropriate pick-up time
- Declaration of decontamination, stating that all hazardous fluids or material have been removed from the product


IMPORTANT This recycling program is not for biological hazard products or for products that have been medically contaminated. You must treat these types of products as biohazard waste and dispose of them in accordance with your local regulations.
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>Accessing Documentation</td>
<td>ix</td>
</tr>
<tr>
<td></td>
<td>Viewing the Product Manuals</td>
<td>ix</td>
</tr>
<tr>
<td></td>
<td>Viewing Online User Documentation</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Providing Documentation Feedback</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Compatible Mass Spectrometers</td>
<td>xi</td>
</tr>
<tr>
<td></td>
<td>Special Notices, Symbols, and Cautions</td>
<td>xi</td>
</tr>
<tr>
<td></td>
<td>Safety Precautions</td>
<td>xii</td>
</tr>
<tr>
<td></td>
<td>Regulatory Compliance</td>
<td>xiii</td>
</tr>
<tr>
<td></td>
<td>Contacting Us</td>
<td>xiv</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Advantages of Nanoelectrospray</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Offline Analysis</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Source Housing</td>
<td>3</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Attaching or Removing the Nanospray Flex Series Ion Source</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Preparing the Mass Spectrometer</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Attaching the Nanospray Flex Series Ion Source</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Connecting Nitrogen Gas</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Removing the Nanospray Flex Series Ion Source</td>
<td>8</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Installing the Cameras and LCD Monitor</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Installing the USB Cameras</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Installing the Analog Cameras and LCD Monitor</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Adjusting the Video Picture</td>
<td>12</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Assembling the LC Plumbing</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Stainless Steel or Glass Emitters</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>One- or Two-Column Configuration</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Using nanoViper Fittings</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Configuring a Stainless Steel Emitter</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Configuring a Glass Emitter and Liquid Junction</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Mounting the UHPLC Liquid Junction Cross onto the DirectJunction</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Additional Resources</td>
<td>23</td>
</tr>
</tbody>
</table>
Contents

Chapter 5 Configuring the DirectJunction Adapter ........................................... 25
Attaching the DirectJunction Adapter .......................................................... 25
Adjusting the Emitter Tip Position ............................................................ 27

Chapter 6 Operating in Offline Nanospray Mode ........................................... 29
Offline Nanospray Source Head ............................................................... 30
Sample Purification ..................................................................................... 30
Attaching the Offline Nanospray Source Head ........................................... 31
Loading Sample onto Borosilicate Emitters .............................................. 32
Installing the Borosilicate Emitter into the Source Head ......................... 33
Opening and Positioning the Borosilicate Emitter .................................... 34
Obtaining a Stable, Low Flow Spray ......................................................... 35

Chapter 7 Configuring the Mass Spectrometer for NSI Mode ....................... 37
Configuring the NSI Parameters for the Nanospray Flex NG Source .......... 37
Configuring the NSI Parameters for the Nanospray Flex Source ................ 38
Selecting the Source for the LCQ Deca XP Max Mass Spectrometer .......... 38

Chapter 8 Troubleshooting ........................................................................ 41

Chapter 9 Replaceable Parts ...................................................................... 45
Spare Parts ................................................................................................. 45
Consumables ............................................................................................. 46

Appendix A Contents of the Installation Kits ............................................... 47

Index ......................................................................................................... 49
## Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Nanospray Flex ion source mounted on a Thermo Scientific mass spectrometer</td>
</tr>
<tr>
<td>2</td>
<td>Nanospray Flex NG ion source (ES072) with the USB cameras (ES218)</td>
</tr>
<tr>
<td>3</td>
<td>Nanospray Flex ion source (ES071) with the USB cameras (ES218)</td>
</tr>
<tr>
<td>4</td>
<td>Examples of the MS ion sweep cones</td>
</tr>
<tr>
<td>5</td>
<td>Ion source locking levers (top view)</td>
</tr>
<tr>
<td>6</td>
<td>Nanospray Flex NG ion source connection</td>
</tr>
<tr>
<td>7</td>
<td>Gas port on the bottom of the ion source</td>
</tr>
<tr>
<td>8</td>
<td>USB cameras installed on the ion source</td>
</tr>
<tr>
<td>9</td>
<td>Hex screw to secure the top camera</td>
</tr>
<tr>
<td>10</td>
<td>nanoViper fitting</td>
</tr>
<tr>
<td>11</td>
<td>UHPLC fused-silica union (cross section, P/N ES272)</td>
</tr>
<tr>
<td>12</td>
<td>Protective cover (side view)</td>
</tr>
<tr>
<td>13</td>
<td>UHPLC liquid junction cross with the bottom protective cover</td>
</tr>
<tr>
<td>14</td>
<td>DirectJunction adapter mounted on the XYZ-manipulator arm (Nanospray Flex)</td>
</tr>
<tr>
<td>15</td>
<td>Diagram showing the 20-degree emitter angle</td>
</tr>
<tr>
<td>16</td>
<td>DirectJunction HV connection (left side view)</td>
</tr>
<tr>
<td>17</td>
<td>Adjustment knobs on the XYZ manipulator (front view)</td>
</tr>
<tr>
<td>18</td>
<td>Offline nanospray ion source head (ES260)</td>
</tr>
<tr>
<td>19</td>
<td>Inserting the StageTip into the borosilicate emitter</td>
</tr>
<tr>
<td>20</td>
<td>Emitter tip bending on the MS spray cone</td>
</tr>
</tbody>
</table>
Preface

The Nanospray Flex Series Ion Source User Guide describes the hardware components, and provides installation and configuration procedures for the Thermo Scientific™ Nanospray Flex™ Series ion sources. Depending on the installed camera type, you view the ion source spray by using the camera software or an LCD monitor that is placed on the mass spectrometer (MS).

Also, because this guide uses drawings of various connections and component parts to help illustrate procedures, be sure to start from 1, no matter where it appears.

Contents

• Accessing Documentation
• Providing Documentation Feedback
• Compatible Mass Spectrometers
• Special Notices, Symbols, and Cautions
• Safety Precautions
• Regulatory Compliance
• Contacting Us

Accessing Documentation

Thermo Scientific MSs include complete documentation.

• Viewing the Product Manuals
• Viewing Online User Documentation

For system requirements, refer to the release notes on the software DVD.
Preface

**Viewing the Product Manuals**

The Thermo Fisher Scientific service engineer installs the instrument control applications and the instrument manuals on the data system computer.

- **To view the product manuals**
  
  From the Microsoft™ Windows™ taskbar, choose **Start > All Apps** (Windows 10) or **All Programs** (Windows 7) > **Thermo Instruments** (or **Thermo model**) and so on, where **model** is the specific MS.

**Viewing Online User Documentation**

Visit the Thermo Fisher Scientific website for product manuals and more.

- **To view user documentation from the Thermo Fisher Scientific website**
  
  1. Go to thermofisher.com.
  2. Point to **Services & Support** and click **Manuals** on the left.
  3. In the Refine Your Search box, search by the product name.
  4. From the results list, click the title to open the document in your web browser, save it, or print it.

    To return to the document list, click the browser **Back** button.

**Providing Documentation Feedback**

- **To suggest changes to the documentation**
  
  Complete a brief survey about this document by clicking the button below. Thank you in advance for your help.
Compatible Mass Spectrometers

Use the Nanospray Flex Series ion source with the appropriate Thermo Scientific MS for nanoelectrospray (commonly referred to as nanoES or nanospray™) analysis. Table 1 lists several compatible MSs. For information about your specific instrument, refer to its manuals.

**CAUTION** If you connect the Nanospray Flex Series ion source to another type of MS, you might impair the safety protection provided by the equipment.

<table>
<thead>
<tr>
<th>Ion source model</th>
<th>Thermo Scientific mass spectrometer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nanospray Flex NG™</td>
<td>Orbitrap™ Tribrid™ Series and TSQ™ Series II</td>
</tr>
<tr>
<td>Nanospray Flex</td>
<td>Exactive™ Series, LCQ Fleet™, LTQ™ Series, Orbitrap Series, and TSQ Series I</td>
</tr>
</tbody>
</table>

* In 2018, the name “Orbitrap Fusion™ Series” changed to “Orbitrap Tribrid Series.”

Special Notices, Symbols, and Cautions

Make sure you understand the special notices, symbols, and caution labels in this guide. Most of the special notices and cautions appear in boxes; those pertaining to safety also have corresponding symbols. Some symbols are also marked on the ion source itself and can appear in color or in black and white. For complete definitions, see Table 2.

**Table 2.** Notices, symbols, labels, and their meanings (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Notice, symbol, or label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMPORTANT</td>
<td>Highlights information necessary to prevent damage to software, loss of data, or invalid test results; or might contain information that is critical for optimal performance of the product.</td>
</tr>
<tr>
<td>Note</td>
<td>Highlights information of general interest.</td>
</tr>
<tr>
<td>Tip</td>
<td>Highlights helpful information that can make a task easier.</td>
</tr>
<tr>
<td>Caution:</td>
<td>Read the cautionary information associated with this task.</td>
</tr>
</tbody>
</table>
Table 2. Notices, symbols, labels, and their meanings (Sheet 2 of 2)

<table>
<thead>
<tr>
<th>Notice, symbol, or label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chemical hazard:</strong></td>
<td>Observe safe laboratory practices and procedures when handling chemicals. Only work with volatile chemicals under a fume or exhaust hood. Wear gloves and other protective equipment, as appropriate, when handling toxic, carcinogenic, mutagenic, corrosive, or irritant chemicals. Use approved containers and proper procedures to dispose of waste oil and when handling wetted parts of the instrument.</td>
</tr>
<tr>
<td><strong>Hot surface:</strong></td>
<td>Allow any heated components to cool before touching them.</td>
</tr>
<tr>
<td><strong>Risk of electric shock:</strong></td>
<td>This source uses voltages that can cause electric shock and personal injury. Before removing the source for servicing, shut down the MS and disconnect it from line power.</td>
</tr>
<tr>
<td><strong>Risk of eye injury:</strong></td>
<td>Eye injury can occur from splattered chemicals, airborne particles, or sharp objects. Wear safety glasses when handling chemicals or servicing the source.</td>
</tr>
<tr>
<td><strong>Sharp object:</strong></td>
<td>Avoid handling the tip of the emitter.</td>
</tr>
<tr>
<td><strong>Trip obstacle:</strong></td>
<td>Be aware of cords or other objects located on the floor.</td>
</tr>
</tbody>
</table>

**Safety Precautions**

Observe the following safety precautions when you operate or perform service on the ion source.

**CAUTION** Do not perform any servicing other than that contained in this manual. To avoid personal injury or damage to the ion source, do not perform any servicing other than that contained in this manual or related manuals unless you are qualified to do so.

**CAUTION** The ion source must connect to a certified Thermo Scientific MS, which supplies high voltage (HV) capable of delivering a maximum of 8 kV and 100 μA. If you connect the source to another type of MS, you might impair the protection provided by the equipment.
Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with applicable North American and European regulations. The Nanospray Flex Series ion sources were tested as part of the Thermo Scientific MS system, which meets the applicable requirements for electromagnetic compatibility (EMC) and product safety. For additional regulatory information, refer to the MS manuals.

Unauthorized changes that you make to your system will void regulatory compliance and may defeat the built-in protections for your instrument. Some examples of unauthorized changes include using replacement parts or adding components, options, or peripherals that Thermo Fisher Scientific has not qualified and authorized. Unauthorized changes can also result in bodily injury and/or damage to your system and laboratory.

Ensure continued compliance with regulatory standards:

- Follow all installation instructions provided in the documentation that comes with your system.
- Order replacement parts (as specified in the instrument manual) and additional components, options, and peripherals directly from Thermo Fisher Scientific or an authorized representative.

CAUTION  Be aware of high voltage components. Before you touch a stainless steel or borosilicate emitter, the liquid flowing through a glass emitter, or the offline source head, depending on the plumbing configuration, make sure that you place the MS in off mode.

CAUTION  Avoid personal injury. Before you remove the emitter, make sure that you depressurize the LC system. Otherwise, the emitter might eject at a high speed and cause personal injury to you or someone nearby.
Contacting Us

<table>
<thead>
<tr>
<th>Contact</th>
<th>Email</th>
<th>Telephone</th>
<th>QR Code^</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Technical Support</td>
<td><a href="mailto:us.techsupport.analyze@thermofisher.com">us.techsupport.analyze@thermofisher.com</a></td>
<td>(U.S.) 1 (800) 532-4752</td>
<td></td>
</tr>
<tr>
<td>U.S. Customer Service and Sales</td>
<td><a href="mailto:us.customer-support.analyze@thermofisher.com">us.customer-support.analyze@thermofisher.com</a></td>
<td>(U.S.) 1 (800) 532-4752</td>
<td></td>
</tr>
</tbody>
</table>

Global Support

- **To find global contact information or customize your request**
  1. Go to thermofisher.com.
  2. Click **Contact Us**, select the country, and then select the type of support you need.
  3. At the prompt, type the product name.
  4. Use the phone number or complete the online form.

- **To find product support, knowledge bases, and resources**
  Go to thermofisher.com/us/en/home/technical-resources.

- **To find product information**

*Note* To provide feedback for this document, go to surveymonkey.com/s/PQM6P62 or send an email message to Technical Publications (techpubs-lcms@thermofisher.com).

^ You can use your smartphone to scan a QR Code, which opens your email application or browser.
Introduction

The Nanospray Flex Series ion source, shown in Figure 1, maintains excellent spray stability to ensure efficient evaporation and ionization of the liquid samples—the key to achieving the highest sensitivity at nano-flow rates.

Key benefits of the Nanospray Flex Series are as follows:

- Flexible, user-friendly design (for configuring custom columns)
- Single setup for all online and offline nanoflow applications
- Ability to interface with online nanoscale LC separation techniques

Contents

- Advantages of Nanoelectrospray
- Offline Analysis
- Source Housing

Figure 1. Nanospray Flex ion source mounted on a Thermo Scientific mass spectrometer
Advantages of Nanoelectrospray

The use of electrospray ionization (ESI) has evolved as a leading technique for generating intact, gas-phase ions from thermally labile, polar analytes in solution. In this technique, an emitter (a capillary tube or needle) induces ionization at a controlled distance from a counter electrode. Direct current (dc) voltage is applied, either to the needle or to the solvent, to produce a strong electrical field at the emitter tip. The electric field excites the ions in the solution as they leave the emitter tip. This interaction results in electrohydrodynamic disintegration of the fluid, generation of droplets, and formation of an aerosol jet.

Conventional ESI employs flow rates from 1 μL/min to 1 mL/min. Expediting desolvation and droplet shrinkage often requires a drying gas, thermal heating, or both, due to the high volume of liquid that exits the emitter. Nanospray ionization (NSI), also known as nanoelectrospray ionization (nanoESI or NSI), is a form of ESI that employs online low rates of 10 to 1000 nL/min. NSI (or nanoESI) generally does not require a drying gas or thermal heating. Compared with ESI, NSI tolerates a wider range of liquid compositions including pure water.

As you lower the flow rate, a lower volume of mobile phase passes through the emitter, producing smaller aerosol droplets. This makes NSI more effective than conventional ESI at concentrating the analyte at the emitter tip, which produces significant increases in sensitivity as demonstrated by the signal response of the MS.

Note The MS’s instrument control applications use the terms nanospray and NSI.

Offline Analysis

Through offline analysis with borosilicate emitters, you can extract the maximum amount of information from very limited amounts of sample. You can also average data extensively to improve the signal-to-noise ratio and conditions optimized for MS/MS experiments. Using the optional offline Nano ES ion source head (ES260), you can do the following:

- Work at low flow rates of 10–40 nL/min.
- Use nearly 100 percent of sample.
- Work effectively with sample volumes down to 300 nL.
- Work with stable sprays over a wide pH range and in high-buffer concentrations.
- Spray from purely aqueous and purely organic solvents.
- Avoid cross-contamination by using disposable emitters.

For additional information, see Operating in Offline Nanospray Mode.
Source Housing

The Nanospray Flex NG (Figure 2) or the Nanospray Flex (Figure 3) ion source is easy to install on the appropriate MS (see Table 1). For installation instructions, see Chapter 2.

The source housing includes two locking levers, an observation cylinder, a position-adjustable column holder, and sliding rails for emitter retraction. Using the observation cylinder, you can view the emitter tip while you move it into position. To enhance your view of the emitter, follow the instructions in Installing the Cameras and LCD Monitor.

Figure 2. Nanospray Flex NG ion source (ES072) with the USB cameras (ES218)
Figure 3. Nanospray Flex ion source (ES071) with the USB cameras (ES218)
Attaching or Removing the Nanospray Flex Series Ion Source

Follow these procedures to install or remove the Nanospray Flex Series ion source.

Contents

• Preparing the Mass Spectrometer
• Attaching the Nanospray Flex Series Ion Source
• Connecting Nitrogen Gas
• Removing the Nanospray Flex Series Ion Source

CAUTION Before you touch a previously operating source or its components, allow the system to cool for a minimum of 20 minutes.

Preparing the Mass Spectrometer

Before you attach the ion source to the instrument, follow this procedure.

❖ To prepare the MS

1. If any other source is installed, remove it after it has cooled to room temperature. For instructions, refer to the instrument documentation.

2. If the ion sweep cone (Figure 4) is installed, let it cool to room temperature, and then remove it by grasping its outer ridges and pulling it off. You might need to use a small slotted screwdriver to loosen the screws. The spray cone is directly behind the ion sweep cone (Figure 6).
2 Attaching or Removing the Nanospray Flex Series Ion Source

Attaching the Nanospray Flex Series Ion Source

CAUTION

- Make sure that you do not accidentally lift the release lever located at the top of the API source interface, which could interfere with or prevent installation of the ion source.
- To avoid contaminating the ion transfer tube, do not touch its exposed entrance.

**Figure 4.** Examples of the MS ion sweep cones

- Ion sweep cone for the Orbitrap Fusion MS
- Ion sweep cone for the legacy MSs (Shown is the offset orifice type for ESI, H-ESI, and APCI.)

**Attaching the Nanospray Flex Series Ion Source**

△ To attach the ion source on the MS

1. Unlock the source’s locking levers (Figure 5).
2. Align the two guide pin holes on the back of the source with the guide pins on the front of the MS (Figure 6).

**Figure 6.** Nanospray Flex NG ion source connection

3. Carefully press the source onto the MS, and then lock the locking levers.
Connecting Nitrogen Gas

If you want to provide a controlled environment in the spray area, you can connect nitrogen gas to the ion source.

(Optional) To connect nitrogen gas to the ion source

Connect clean, dry nitrogen gas with a flow rate of 0–5 L/min to the 1/8 in. OD Swagelok™ fitting on the bottom of the source.

Figure 7. Gas port on the bottom of the ion source

Removing the Nanospray Flex Series Ion Source

To remove the ion source from the MS

1. Turn off the LC liquid flow to the source.
2. Disconnect the LC plumbing.
3. As applicable, disconnect the cameras and monitor connections, including their power supplies.
4. After the system has cooled to room temperature, unlock the source’s locking levers.
5. Grasp the source housing with both hands and slowly pull it away from the MS.

The MS automatically switches to off mode after a few seconds.

You can now store the source until its next usage. The Nanospray Flex Series ion source does not require cleaning.
Installing the Cameras and LCD Monitor

Depending on your camera model (Table 3), follow the applicable procedure to install the two cameras, with or without the monitor. Afterwards, follow the applicable procedure in Adjusting the Video Picture.

Contents

• Installing the USB Cameras
• Installing the Analog Cameras and LCD Monitor
• Adjusting the Video Picture

Table 3. Camera types and installation procedures

<table>
<thead>
<tr>
<th>Camera</th>
<th>P/N</th>
<th>Monitor?</th>
<th>Procedurea</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dino-Lite™, USB (2 provided)</td>
<td>ES218</td>
<td>No</td>
<td>To install the USB cameras</td>
</tr>
<tr>
<td>Dino-Lite, analog (2 provided)</td>
<td>ES216</td>
<td>Yesb</td>
<td>To install the analog cameras and LCD monitor</td>
</tr>
</tbody>
</table>

a Might require a 1.5 mm hex key to complete.
b LCD monitor (P/N ES217)
3 Installing the Cameras and LCD Monitor

Installing the USB Cameras

Using the DinoCapture™ application through the data system computer, you can use the monitor to view the spray exiting the emitter tip.

❖ To install the USB cameras

1. Install the camera’s DinoCapture application onto the data system computer.

**IMPORTANT** You must install this application before connecting the camera cables to the data system computer.

2. With the focusing wheel facing toward you, slowly press the cameras into the top and side camera opening (Figure 8).

**Figure 8.** USB cameras installed on the ion source

3. (Optional) Connect each camera to a USB extension cord.

4. Plug the USB cords into the data system computer’s USB ports.

**IMPORTANT** Do not connect the cameras to a USB hub.

**Tip** For troubleshooting purposes, record the USB port used for each camera.
Installing the Analog Cameras and LCD Monitor

**CAUTION** After completing these connections, route all cables and power cords so that they are not a trip hazard.

✧ **To install the analog cameras and LCD monitor**

1. Install the monitor as follows:
   a. On the back, attach BNC adapters (if provided) to both Video IN ports.
   b. Connect the power supply for the monitor between the DC 12V IN socket and an electrical outlet.
   c. Place the monitor on top of the MS near the source, making sure that it is not too close to the edge of the instrument.

2. Install each camera as follows:
   a. Using a 1.5 mm hex key, loosen the hex screw near the camera opening, and then insert the camera with its focusing wheel facing toward you (Figure 9).
   b. Tighten the hex screw until it touches the camera—do not overtighten it.
   
   **Figure 9.** Hex screw to secure the top camera

   ![Securement screw](image1.png)
   ![Camera focusing wheel](image2.png)

   c. Connect the yellow video connector to the monitor’s Video IN port (see step 1a).
   d. Connect the black connector to its power supply, and then connect the power supply to an electrical outlet.
Adjusting the Video Picture

Depending on your camera model, follow the applicable step to focus the video picture. As needed, refer to the manuals for the cameras and monitor.

❖ To adjust the video picture

• For the USB camera application, do the following:
  i. In the DinoCapture window, use the mouse to move the visible video image off of the second image, and then adjust the display size as needed.
  ii. If the picture is too dark, turn on each camera’s light.
  iii. If the picture is out of focus, adjust each camera’s focusing wheel.

• For the LCD monitor, do the following:
  i. Turn on the monitor by pressing its POWER button.
  ii. If the picture is too dark, turn on each camera’s light.
  iii. If the picture is out of focus, adjust each camera’s focusing wheel.
  iv. To display the other camera input, press the SOURCE button.

    The monitor displays the selected video input channel (AV1 or AV2) for a few seconds.

Tip To learn more about this application, such as the measurement and time-lapse video features, choose Help > FAQ or User's Guide.
Assembling the LC Plumbing

After you decide how many columns you need for your LC analysis and what type of emitter to use, follow the applicable procedure in this chapter to assemble the plumbing for the DirectJunction adapter.

**CAUTION** Wear protective gloves and safety glasses when handling the solvent lines. To prevent contamination, wear lint-free and powder-free gloves.

**Contents**

- Stainless Steel or Glass Emitters
- One- or Two-Column Configuration
- Using nanoViper Fittings
- Configuring a Stainless Steel Emitter
- Configuring a Glass Emitter and Liquid Junction
- Mounting the UHPLC Liquid Junction Cross onto the DirectJunction
- Additional Resources

**Stainless Steel or Glass Emitters**

The MS energizes the stainless steel (SS) emitter through the high-voltage (HV) connection on the ion source’s DirectJunction adapter. When you use a glass emitter, the plumbing configuration includes the Liquid Junction adapter, which energizes the liquid flow that passes the HV electrode.

SS emitters are more robust than glass emitters and help maintain a stable spray for longer periods of time.

Glass emitters can have very small openings. However, the very small opening at the emitter tip often results in stability problems associated with blockage, which means that glass emitters rarely last as long as the SS emitters.
Some consider glass emitters to be more bio-inert than SS emitters. This might reduce the risk of nonspecific adsorption of biomolecules and lead to slightly improved sensitivity. However, the degree of this adsorption, and thus the performance change, depends on the chemical characteristics of the sample.

**IMPORTANT** For glass emitters, do the following:

- Place the Liquid Junction adapter on the high-pressure side of the column. Electrochemical processes that occur at the electrode can otherwise create gas that leads to spray instability.
- Use glass emitters with small ID emitter tips (less than 20 μm) to create back pressure in the emitter and avoid outgassing and consequent spray instability.

### One- or Two-Column Configuration

The Nanospray Flex Series installation kit includes the DirectJunction adapter, which supports both one- and two-column configurations. The following table describes some of the advantages for each configuration.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Advantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-column</td>
<td>• Fewer connections, which minimize any potential peak broadening that results from dead volumes.</td>
</tr>
<tr>
<td></td>
<td>• Enables MS analysis of compounds that elute during sample loading (as they might not bind to the column material) because the fluid path leads directly to the instrument.</td>
</tr>
<tr>
<td>Two-column</td>
<td>• Use of a shorter pre-analytical column (precolumn). This provides an increased loading capacity and loading flow rate when compared to loading sample directly onto the longer analytical column.</td>
</tr>
<tr>
<td></td>
<td>• The precolumn acts as a guard column by protecting the analytical column from particulate matter.</td>
</tr>
</tbody>
</table>

### Using nanoViper Fittings

For some LC instruments, the plumbing connections include several nanoViper™ fittings, such as the one shown in Figure 10. Although these fittings can withstand ultra-high-performance LC (UHPLC) backpressures up to ~1200 bar (~17 400 psi), they are fingertight fittings that require only very small torques to seal. Therefore, you must follow the next procedure to avoid damage by overtightening.
To use a nanoViper fitting

1. Insert the nanoViper fitting into the target port and slowly rotate the screw clockwise until you feel resistance.

2. Using the black knurled fitting tool, tighten the screw clockwise to an angle of 0–45 degrees (1/8-turn).

3. Start operating the system at the desired working pressure and check the backpressure.

4. If the backpressure is too low, check the system for leaks.
   For instructions, refer to the LC instrument’s documentation.

5. If the backpressure continues to be too low, return the system to atmospheric pressure.

6. Tighten the screw by as much as an additional 45 degrees. Do not turn the screw beyond an angle of 90 degrees from where you felt the initial resistance.

**IMPORTANT** To prevent damage to the sealing surface of the nanoViper fitting, do not overtighten the fitting.
4 Assembling the LC Plumbing
Configuring a Stainless Steel Emitter

Configuring a Stainless Steel Emitter

For a stainless steel (SS) emitter with two columns, follow this HPLC procedure, which shows the recommended configuration. For a one-column configuration, start with Step 2. Make sure that the tubing, sleeves, and unions are compatible and appropriate for the connection method and pressure range.

**IMPORTANT** Install the emitter last to avoid damaging its tip.

❖ **To configure a stainless steel emitter and two columns for HPLC (max. 300 bar)**

1. (2-column setup only) Insert a PEEK sleeve on the input end of the **precolumn**, and then insert it into the ZDV union. Insert the other end into the HPLC venting Tee.

   **Note** Make sure that the precolumn’s flow arrow points away from the union.

2. Insert a PEEK sleeve on the output end of the **analytical column**, and then insert it into the second ZDV union. Insert the other end into the venting Tee.

   **Note** Make sure that the column’s flow arrow points away from the venting Tee.

3. Insert the venting Tee in the multipurpose adapter.

4. Connect the “Column Out” line to the ZDV union (2-column setup) or to the HPLC venting Tee (1-column setup).

5. Connect the LC “Waste In” line to the HPLC venting Tee.

6. Carefully insert the sleeved end of the **SS emitter** into the ZDV union. The DirectJunction’s HV clamp holds the emitter.

7. After installing the DirectJunction, connect its cable to the source’s bottom.
To configure a stainless steel emitter and two columns for UHPLC (over 300 bar)

1. (2-column setup only) Insert a PEEK sleeve on the input end of the **precolumn**, and then insert it into the UHPLC fused-silica union. Insert the other end into the UHPLC venting Tee.

   **Note** Make sure that the precolumn’s flow arrow points away from the union.

2. Insert a PEEK sleeve on the output end of the **analytical column**, and then insert it into the ZDV union. Insert the other end into the venting Tee.

   **Note** Make sure that the column’s flow arrow points away from the venting Tee.

3. Insert the UHPLC fused-silica union in the multipurpose adapter.

4. Connect the “**Column Out**” line to the UHPLC fused-silica union (2-column setup) or to the UHPLC venting Tee (1-column setup).

5. Connect the LC “**Waste In**” line to the UHPLC venting Tee.

6. Carefully insert the sleeved end of the **SS emitter** into the ZDV union. The DirectJunction’s HV clamp holds the emitter.

7. After installing the DirectJunction, connect its cable to the source’s bottom.
Configuring a Glass Emitter and Liquid Junction

For a glass emitter with two columns, follow the applicable HPLC or UHPLC procedure, which shows the recommended configurations. For a one-column configuration, start with Step 2. Make sure that the tubing, sleeves, and unions are compatible and appropriate for the connection method and pressure range.

**IMPORTANT**  Install the emitter last to avoid damaging its tip.

**Note**

- Use small ID emitter tips (less than 20 μm) to prevent outgassing in the tip and subsequent spray instability.
- The packed-glass emitter contains the stationary phase and has dual roles: as the analytical column and the emitter. The packed-glass emitter is inserted through the ZDV union, which only holds the emitter in place.
- To use a longer analytical column (greater than 20 cm), coil it between the venting Tee and ZDV union.

**CAUTION**  *Avoid contact with high voltage.* Before you start, make sure that the cable from the UHPLC liquid junction cross is disconnected.
To configure a glass emitter and two columns for HPLC (max. 300 bar)

1. (2-column setup only) Insert a PEEK sleeve on the input end of the precolumn, and then insert it into the ZDV union. Insert the other end into the HPLC liquid junction cross.
   
   **Note** Make sure that the precolumn’s flow arrow points away from the union.

2. (Option 1 – shown) Insert a PEEK sleeve on the output end of the analytical column, and then insert it into the second ZDV union. Insert the other end into the HPLC liquid junction cross.
   
   **Note** Make sure that the column’s flow arrow points away from the liquid junction cross.

3. Connect the liquid junction HV cable to the junction cross and the source bottom.

4. Insert the liquid junction cross in the multipurpose adapter.

5. Connect the “Column Out” line to the ZDV union (2-column setup) or the HPLC venting Tee (1-column setup).

6. Connect the LC “Waste In” line to the HPLC liquid junction cross (ES257).

7. Carefully insert the sleeved end of the glass or packed-glass emitter into the ZDV union. The DirectJunction’s HV clamp holds the emitter.

8. Do not connect the DirectJunction cable.
To configure a glass emitter and two columns for UHPLC (over 300 bar)

**CAUTION Avoid contact with high voltage.** The UHPLC liquid junction cross operates at high voltage. Make sure that you securely mount the cross to the DirectJunction adapter inside its two-piece protective cover.

**IMPORTANT** If the columns are less than 360 μm OD, add PEEK sleeves to the ends before inserting them into the UHPLC liquid junction cross.

1. Assemble and mount the **UHPLC liquid junction cross** (ES269); see page 21. Connect the HV cable to the source's bottom.

2. (2-column setup only) Insert a PEEK sleeve on the unattached end of the **precolumn**, and then insert it into the UHPLC fused-silica union.

   **Note** Make sure that the precolumn's flow arrow points away from the union.

3. Connect the “**Column Out**” line to the UHPLC union (2-column setup) or the UHPLC liquid junction cross (1-column setup).

4. (Option 1 – shown) Insert a PEEK sleeve on the unattached end of the **analytical column**, and then insert it into a ZDV union.

   **Option 2** Instead of an analytical column, insert a **packed-glass emitter** into the UHPLC liquid junction cross and slide the other end through a ZDV union.

   **Note** Make sure that the column's flow arrow points away from the venting Tee.

5. Carefully insert the sleeved end of the **glass or packed-glass emitter** into the ZDV union. The DirectJunction's HV clamp holds the emitter.

6. **Do not** connect the DirectJunction cable.
Mounting the UHPLC Liquid Junction Cross onto the DirectJunction

The UHPLC liquid junction cross, which is included in the UHPLC Liquid Junction Kit (ES269), is for use with glass-emitter LC configurations. Using the tools and equipment listed in Table 4, follow the procedures in this section to mount the cross onto the DirectJunction adapter.

Table 4. Tools and equipment

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gloves, lint-free and powder-free</td>
<td>Fisher Scientific™ 19-120-2947&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>Unity Lab Services:</td>
</tr>
<tr>
<td></td>
<td>• 23827-0008 (medium size)</td>
</tr>
<tr>
<td></td>
<td>• 23827-0009 (large size)</td>
</tr>
<tr>
<td>Screwdriver, slotted, small</td>
<td>–</td>
</tr>
<tr>
<td>UHPLC Liquid Junction Kit, includes a tightening tool</td>
<td>ES269</td>
</tr>
</tbody>
</table>

<sup>a</sup> Multiple sizes are available.

Figure 11 shows that the ends of the externally threaded PEEK holder have different internal depths. The internal stainless steel cartridge sits within the deeper end of the PEEK holder. The microferrule ends are for use with sleeveless, 360 μm OD fused-silica tubing, which are secured by the two internally threaded knurled nuts.

Figure 11. UHPLC fused-silica union (cross section, P/N ES272)
To mount the UHPLC liquid junction cross onto the DirectJunction

1. Using the slotted screwdriver, remove the screws from the top protective cover.

   Figure 12 shows a side view of the two-piece protective cover.

   **Figure 12.** Protective cover (side view)

2. Place the bottom cover under the DirectJunction’s metal rod. If necessary, loosen the compression screw to adjust the hole size, and then tighten the screw.

3. Place the UHPLC liquid junction cross into the bottom protective cover, and then attach the top cover by using the slotted screwdriver.

   **Figure 13.** UHPLC liquid junction cross with the bottom protective cover

4. After you complete the plumbing connections, connect the HV cable to the source bottom.
Additional Resources

For general information about configuring Thermo Scientific nanoLC sources, log in (free) to planetorbitrap.com, choose Library > Scientific Library > Keyword, and search for A1969.

Refer to the Thermo Scientific EASY-nLC™ Series documentation for the following:

- Setting up the column assembly
- Modifying the LC instrument before connecting it to the UHPLC Liquid Junction adapter on the Nanospray Flex Series ion source

For other LC instruments, refer to their documentation.
4 Assembling the LC Plumbing

Additional Resources
Configuring the DirectJunction Adapter

After you attach the DirectJunction adapter to the Nanospray Flex Series ion source, adjust the emitter position.

Contents

• Attaching the DirectJunction Adapter
• Adjusting the Emitter Tip Position

Attaching the DirectJunction Adapter

You can attach the LC plumbing to the DirectJunction adapter before or after you attach the adapter to the source’s manipulation arm.

❖ To attach the DirectJunction adapter to the ion source
1. Pull out the bottom of the source to fully expose the XYZ-manipulator arm (Figure 14).
2. Using the 3 mm hex key, loosely attach the DirectJunction adapter to the XYZ-manipulator arm with the provided screw.

Note The longer screw provided with the DirectJunction is for the Nanospray Flex NG source, which has a wider manipulator arm.
3. Attach the one- or two-column LC configuration to the adapter as shown on page 16, page 19, or page 20.

**IMPORTANT** Avoid handling the emitter tip when you attach the LC plumbing.

4. Elevate the adapter’s free end approximately 20 degrees (Figure 15), and then firmly tighten the screw.

**Figure 14.** DirectJunction adapter mounted on the XYZ-manipulator arm (Nanospray Flex)

**Figure 15.** Diagram showing the 20-degree emitter angle

Values for stainless steel or fused-silica emitters:

- $A = 3–5$ mm; potential on the emitter = 1500–2200 V
5. Attach the HV cable to the socket on the source’s bottom (Figure 16).

The DirectJunction cable (with an SS emitter) or the Liquid Junction cable (with a glass or packed glass emitter) connects to the bottom of the source.

**Figure 16.** DirectJunction HV connection (left side view)

---

**Adjusting the Emitter Tip Position**

After you attach the DirectJunction Adapter to the manipulator arm, follow this procedure to make any needed positional adjustments for the emitter tip.

넷 To adjust the emitter tip position

1. Using the XYZ-manipulator knobs (Figure 17), position the emitter tip almost on-axis with the ion transfer tube.

2. As you make adjustments, observe the distance on the monitor. If necessary, follow the procedure, Adjusting the Video Picture.
5 Configuring the DirectJunction Adapter
Adjusting the Emitter Tip Position

Figure 17. Adjustment knobs on the XYZ manipulator (front view)

CAUTION  Be aware of accessible high voltage components. Although the source is shielded, you can easily access its head. Always make sure that the MS is in off mode before you touch the source head. Do not leave the source unattended while the spray voltage is on.
Operating in Offline Nanospray Mode

Use offline NSI mode with the Nanospray Flex Series ion source when your LC/MS setup does not include an active sample flow from an LC instrument or the MS syringe pump. For offline NSI mode, mount the offline nanospray source head to the ion source and use Thermo Scientific borosilicate emitters.

Contents

- Offline Nanospray Source Head
- Sample Purification
- Attaching the Offline Nanospray Source Head
- Loading Sample onto Borosilicate Emitters
- Installing the Borosilicate Emitter into the Source Head
- Opening and Positioning the Borosilicate Emitter
- Obtaining a Stable, Low Flow Spray
Offline Nanospray Source Head

The offline nanospray source head (Figure 18), which you can order separately, includes the necessary items for offline analysis. This ion source head contains a custom-made conductive ferrule that makes establishing a proper electrical contact easier between the source head and the borosilicate emitter. A fingertight fitting makes tightening and locking the emitter in the source head also easier. The red PEEK fitting with the 1/16 in. Tefzel™ tubing provides a fixed gas backpressure.

Figure 18. Offline nanospray ion source head (ES260)

Sample Purification

The presence of salts, non-volatile buffers, and other polymeric materials (such as those from electrophoresis gels) can affect sample analysis. High amounts of salts might block the emitter, which causes spray instability and low sensitivity due to the presence of salt adducts. This optional purification step can eliminate these issues and concentrate the analytes.

Thermo Fisher Scientific provides a range of StageTips for micro-purification and desalting. For recommended part numbers, see Consumables. The recommended StageTips are based on an Eppendorf™ GEloader™ pipette tip with a long narrow tip. To ensure minimal sample loss, you can insert the tip into the borosilicate emitter to directly deposit the sample onto the emitter.
Attaching the Offline Nanospray Source Head

**CAUTION** Avoid contact with high voltage. Before installing the offline NSI source head, pull the source bottom away from the MS. Then, disconnect the HV cable from the UHPLC liquid junction cross (if installed), and remove the DirectJunction adapter from the XYZ-manipulator arm.

- **To attach the offline source head to the ion source**
  1. Using a 5 mm hex key, remove the hex screw from the offline nanospray source head, and then connect the source head to the XYZ-manipulator arm with that screw.
  2. Connect the HV connector (black cable) to the source’s bottom socket.
  3. Connect the red syringe cap (luer lock screw), which is attached to the tubing, to the syringe tip.
  4. To keep pressure on the syringe, place it in the static air pressure device with the backing plate pressed into one of the slots.
Loading Sample onto Borosilicate Emitters

You can load sample onto borosilicate glass emitters either directly or after a purification step. The tools for this procedure are in the Offline Nanospray (Nano ES) Source Head Kit ES259.

To load sample onto a borosilicate emitter

1. Using the precision tweezers, remove an emitter from the transport container.

2. Using the glass cutter, shorten the emitter length to minimize contact between the sample and the glass walls.

3. (Optional) Use a StageTip to elute the sample directly into the emitter as follows:
   a. Insert the StageTip pipette tip as far as possible into the emitter without blocking the passage of air that must exit the emitter.

   Figure 19. Inserting the StageTip into the borosilicate emitter

   b. If the sample is above the tapered end, shake down the liquid by flicking your wrist or use a table centrifuge.

Note: Always point the emitter tip downwards to prevent sample from moving up the sides.
Installing the Borosilicate Emitter into the Source Head

CAUTION  Avoid personal injury. Before you remove the emitter, make sure that you depressurize the system and disconnect the HV cable to the source bottom. Otherwise, the emitter might eject at a high speed and cause personal injury to you or someone nearby.

❖  To install the borosilicate emitter

1. Using the precision tweezers, insert the sample-loaded emitter into the fitting on the source head.

2. With your fingers, tighten the fitting to provide an airtight fit.

IMPORTANT The internal ferrule is electrically conductive, providing high voltage to the emitter.
Opening and Positioning the Borosilicate Emitter

Thermo Fisher Scientific recommends that you practice the following procedure with standard sample before using more important samples. If you bend the emitter too far, it might break, resulting in an orifice diameter that is too wide and a sample flow that is too high.

To open and position the borosilicate emitter

1. Ensure that the MS is in off mode.
2. Open the emitter tip as follows:
   a. Apply pressure to the sample by pressing the syringe plunger about halfway in.
   b. Using the XYZ-manipulator arm, offset the emitter from the entrance into the MS.
   c. Slowly push the source bottom toward the MS until the emitter tip gently touches the MS spray cone (Figure 20).

   The slim end of the emitter bends slightly and a small droplet appears when the emitter opens. You can retract this droplet into the emitter by relaxing the air pressure with the syringe. If the emitter does not open, slide the tip vertically or horizontally over the sides of the spray cone.

   Figure 20. Emitter tip bending on the MS spray cone

3. Position the emitter tip as follows:
   a. Using the XYZ-manipulator arm, position the emitter tip 1–3 mm in front of the entrance to the MS spray cone.
   b. Using your fingers, loosen the black screw on the source head, raise the back of the emitter to an angle of 0–90 degrees above the tip, and then tighten the screw.
Obtaining a Stable, Low Flow Spray

With the syringe in the static air pressure device, apply enough air pressure to obtain a stable signal with a good signal-to-noise ratio. The gas-tight syringe and the spray head create a loss-free system (unless O-rings or ferrules are damaged).

A stable spray typically lasts at least 30 minutes with 1 μL of liquid. If the spray stops before depleting the sample, the most likely cause is a blocked emitter.

❖ To restart the stopped spray

Try the following:

a. With the spray voltage turned on, release and reapply the backing air pressure to create a negative backpressure a few times. If there is no effect, briefly apply the maximum backing pressure.

b. Repeat step a to open the emitter tip but with the spray voltage turned off.
6 Operating in Offline Nanospray Mode

Obtaining a Stable, Low Flow Spray
Configuring the Mass Spectrometer for NSI Mode

Follow the applicable procedure in this chapter to configure the Thermo Scientific MS for nanoelectrospray ionization (nanoESI or NSI) mode.

**IMPORTANT** Before you begin NSI analysis, check that the source's bottom is pushed completely toward the instrument; otherwise, an error message appears.

**Contents**
- Configuring the NSI Parameters for the Nanospray Flex NG Source
- Configuring the NSI Parameters for the Nanospray Flex Source
- Selecting the Source for the LCQ Deca XP Max Mass Spectrometer

**Configuring the NSI Parameters for the Nanospray Flex NG Source**

After you complete the instrument configuration, use the Thermo Tune application to configure the NSI source parameters. For additional information, refer to the Tune Help.

- **To set the NSI source parameters in Tune**
  1. Open the Tune application by choosing **Start > All Apps** (Windows 10) or **All Programs** (Windows 7) > **Thermo Instruments** (or **Thermo Model**) and so on.
  2. Click **Ion Source**, and then click the **Ion Source** tab to view the Ion Source page.
    
    The MS automatically detects and enters the source type (NSI) in the Ion Source Type box.
  3. In the Pos Ion Spray Voltage (V) box, enter **1900**.
    
    Use 1900 V as the start value for the spray voltage. If the intensity of the full-scan spectrum is low, gradually increase the spray voltage to improve the spectrum. The recommended range for the spray voltage is 1500–2200 V.
  4. In the Sweep Gas (Arb) box, enter **0**.
  5. Click **Apply**.
Configuring the NSI Parameters for the Nanospray Flex Source

After you complete the instrument configuration, use the Thermo Tune Plus application to configure the NSI source parameters. For additional information, refer to the Tune Plus Help.

❖ To set the NSI source parameters in Tune Plus

1. Open the Tune Plus application by choosing Start > All Apps (Windows 10) or All Programs (Windows 7) > Thermo Instruments (or Thermo Model) and so on.
2. Choose Setup > NSI Source to open the NSI Source dialog box.
3. In the Spray Voltage (kV) box, enter 1.90.
   Use 1.90 kV as the start value for the spray voltage. If the intensity of the full-scan spectrum is low, gradually increase the spray voltage to improve the spectrum. The recommended range for the spray voltage is 1.50–2.20 kV.
4. Click OK.

Selecting the Source for the LCQ Deca XP Max Mass Spectrometer

Note This section is for the LCQ Deca XP Max™ MS, which uses the Xcalibur™ data system version 2.0.7 or earlier.

After you install the Nanospray Flex ion source, use the Instrument Configuration window to configure the MS for NSI mode.

❖ To configure the MS for NSI mode

1. On the Windows taskbar, choose Start > All Programs > Xcalibur > Instrument Configuration to open the Instrument Configuration window.
2. Select the devices to control from the Xcalibur data system if they are not already selected:
   a. In the Device Types list, select All.
   b. Under Available Devices, double-click the icons for the MS and nanoelectrospray LC instrument to add them to the Configured Devices list.
3. Double-click the instrument icon to open the Model Configuration dialog box.
4. In the left pane, select Ion Source to display the source configuration page, and then select Nanospray in the Default Source list.
5. Click OK, and then click OK again to close the message box.
6. Configure the LC device if you have not done so.
   For instructions, refer to the LC instrument documentation.
7. In the Instrument Configuration window, click **Done**.
8. Restart the data system computer and the MS.
7 Configuring the Mass Spectrometer for NSI Mode
Selecting the Source for the LCQ Deca XP Max Mass Spectrometer
Troubleshooting

Typical problems with the Nanospray Flex Series ion source relate to one or both cameras or to the signal intensity. For troubleshooting tips, see Table 5. If you need further assistance, contact your local Thermo Fisher Scientific service engineer. See Contacting Us.

Table 5. Nanospray Flex Series ion source problems, causes, and possible solutions (Sheet 1 of 3)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Camera issues</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The light is not on.</td>
<td>One or both camera lights are off.</td>
<td>Turn on one or both cameras by pressing their light buttons (Figure 3).</td>
</tr>
<tr>
<td>–or–</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The video output is too dark.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Signal issues</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The signal intensity is weak.</td>
<td>There is a leak somewhere in the liquid path.</td>
<td>Check all of the LC connections.</td>
</tr>
<tr>
<td></td>
<td>The parameters for the LC, MS, or both might need adjusting.</td>
<td>Try these solutions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify that the emitter is correctly positioned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check the LC method and MS Tune method parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Run a known standard to check the sensitivity.</td>
</tr>
<tr>
<td></td>
<td>The MS’s spray cone and ion transfer tube are dirty.</td>
<td>Clean both the spray cone and ion transfer tube. For instructions, refer to the instrument documentation.</td>
</tr>
</tbody>
</table>

Table 5 (Sheet 2 of 3)
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The spray is unstable.</td>
<td>There is a leak somewhere in the liquid path.</td>
<td>Check all of the LC connections.</td>
</tr>
<tr>
<td>–or– There is no spray.</td>
<td>Air bubbles in the emitter might cause the spray to “spit.”</td>
<td>Try degassing the mobile phase or purging the line, and then recheck the line for air bubbles.</td>
</tr>
<tr>
<td></td>
<td>There is an emitter blockage from particles in the sample, other small particles from the flow lines or valves, and so on.</td>
<td>Try adjusting the spray voltage. If that does not resolve the blockage problem, replace the emitter or column.</td>
</tr>
<tr>
<td></td>
<td>The cleaning solvent is not LC/MS grade, which can negatively affect the spray stability.</td>
<td>Use an LC/MS-grade solvent to clean the emitter tip.</td>
</tr>
<tr>
<td></td>
<td>The emitter is out of alignment, which might occur if you bumped the source or moved the source from one MS to another MS.</td>
<td>Follow the procedure To adjust the emitter tip position.</td>
</tr>
<tr>
<td></td>
<td>The HV connection to the stainless steel emitter might be loose or dirty.</td>
<td>After you place the MS in off mode, check the HV cable connection on the DirectJunction adapter.</td>
</tr>
</tbody>
</table>
The spray is unstable.  
–or–  
There is no spray.

- The source’s HV connection might be unstable.

Check the high voltage contact on the back of the source (Figure 6) and the front of the MS.

If the problem continues for the Nanospray Flex NG source, do the following:

1. Open Tune and view the Ion Source – Ion Source page.
2. Compare the setting for the spray voltage to the adjacent readback value.

A green box ( ) indicates that the parameter is functioning properly.

If the problem continues for the Nanospray Flex source, do the following:

1. Open Tune Plus, choose View > Display Status View, and then click the All tab.
2. Choose Setup > NSI Source to open the NSI Source dialog box.
3. Compare the setting in the dialog box to the readback value for the NSI source’s absolute spray voltage.

A green check mark ( ) indicates that the parameter is functioning properly.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The spray is unstable.  
–or–  
There is no spray. | The source’s HV connection might be unstable. | Check the high voltage contact on the back of the source (Figure 6) and the front of the MS. |

If the problem continues for the Nanospray Flex NG source, do the following:

1. Open Tune and view the Ion Source – Ion Source page.
2. Compare the setting for the spray voltage to the adjacent readback value.

A green box ( ) indicates that the parameter is functioning properly.

If the problem continues for the Nanospray Flex source, do the following:

1. Open Tune Plus, choose View > Display Status View, and then click the All tab.
2. Choose Setup > NSI Source to open the NSI Source dialog box.
3. Compare the setting in the dialog box to the readback value for the NSI source’s absolute spray voltage.

A green check mark ( ) indicates that the parameter is functioning properly.
## Replaceable Parts

To order any of these parts for the Nanospray Flex Series ion source, contact your local Thermo Fisher Scientific service engineer.

### Spare Parts

<table>
<thead>
<tr>
<th>Component Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera, analog (composite video) interface, and power supply</td>
<td>ES216</td>
</tr>
<tr>
<td>Camera, USB interface, and software disc</td>
<td>ES218</td>
</tr>
<tr>
<td>LCD monitor and power supply</td>
<td>ES217</td>
</tr>
<tr>
<td>Offline Nano ES ion source head</td>
<td>ES260</td>
</tr>
<tr>
<td>Replacement Ferrules and O-Ring Kit</td>
<td>ES294</td>
</tr>
<tr>
<td>USB extension cord</td>
<td>00302-99-00095</td>
</tr>
</tbody>
</table>

### Conductive Emitter Configurations

<table>
<thead>
<tr>
<th>Component Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Junction adapter (includes ZDV union SC600)</td>
<td>ES256</td>
</tr>
<tr>
<td>Liquid junction Tee 1/32</td>
<td>ES258</td>
</tr>
<tr>
<td><strong>Offline Nanospray (Nano ES) Source Head Kit</strong></td>
<td>ES259</td>
</tr>
<tr>
<td>Emitters, borosilicate (100 pieces)</td>
<td>ES380</td>
</tr>
<tr>
<td>Offline nanospray ion source head</td>
<td>ES260</td>
</tr>
<tr>
<td>Precision tweezers and ceramic glass cutter</td>
<td>ES250</td>
</tr>
<tr>
<td>Static air pressure device</td>
<td>ES242</td>
</tr>
<tr>
<td>Spare parts, including conductive ferrules and O-ring</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Nonconductive Emitter Configurations

<table>
<thead>
<tr>
<th>Component Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPLC liquid junction cross 1/32</td>
<td>ES257</td>
</tr>
<tr>
<td>HPLC micro union kit 1/32, PEEK, red</td>
<td>G10-0035</td>
</tr>
<tr>
<td><strong>UHPLC Liquid Junction Kit (360 µm OD tubing)</strong></td>
<td>ES269</td>
</tr>
<tr>
<td>Tightening tool</td>
<td>P-278 (IDEX™)</td>
</tr>
<tr>
<td>Tubing, column-out</td>
<td>6041.5290</td>
</tr>
<tr>
<td>Tubing, waste-in</td>
<td>6041.5289</td>
</tr>
<tr>
<td>UHPLC blind ferrule plugs</td>
<td>P-116 (IDEX)</td>
</tr>
<tr>
<td>UHPLC cross, 360 µm</td>
<td>UH-752 (IDEX)</td>
</tr>
<tr>
<td>UHPLC fused-silica union (use with ES269)</td>
<td>ES272</td>
</tr>
<tr>
<td>UHPLC microferrules</td>
<td>PK-152 (IDEX)</td>
</tr>
</tbody>
</table>
Consumables

Emitters, SilicaTip™, uncoated .......................... FS360-20-10-N-5-105CT (New Objective)
Emitters, borosilicate, long (1.1 mm tip), 52 mm long, Au/Pd double coating,
(100 pieces) .................................................. ES388
Emitters, borosilicate, medium (0.8 mm tip), 52 mm long, Au/Pd double coating,
(100 pieces) .................................................. ES387
Emitters, borosilicate, medium (0.8 mm tip), 52 mm long, Au/Pd single coating,
(100 pieces) .................................................. ES380
StageTips, C8, GELoader pipette tip (96 pieces) .................. SP121
StageTips, C18, GELoader pipette tip (96 pieces) .................. SP101
StageTips, SCX, GELoader pipette tip (96 pieces) .................. SP141
For other consumables, visit www.fishersci.com and www.unitylabservices.com.
Contents of the Installation Kits

Table 6 lists the parts supplied in the Nanospray Flex NG Ion Source Kit (P/N ES072) and the Nanospray Flex Ion Source Kit (P/N ES071), which are identical except for the source housing. For a list of replaceable parts, see Chapter 9, “Replaceable Parts.”

**Note** As of 2018, these ion source kits exclude the LCD monitor (P/N ES217) and the 1.5 mm hex key.

Table 6. Contents of the Nanospray Flex Series ion source kits (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Image</th>
<th>Part</th>
<th>Quantity</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provided in the Nanospray Flex NG Ion Source Kit (P/N ES072)</td>
<td>See Figure 2.</td>
<td>Nanospray Flex NG housing</td>
<td>1</td>
</tr>
<tr>
<td>Provided in the Nanospray Flex Ion Source Kit (P/N ES071)</td>
<td>See Figure 3.</td>
<td>Nanospray Flex housing</td>
<td>1</td>
</tr>
<tr>
<td>Provided in both ion source kits</td>
<td>Dino-Lite analog cameras and power supplies</td>
<td>2</td>
<td>ES216</td>
</tr>
<tr>
<td></td>
<td>--or--</td>
<td>Dino-Lite USB cameras and software disc; USB extension cords</td>
<td>ES218 (cameras); 00302-99-00095 (cords)</td>
</tr>
<tr>
<td></td>
<td>DirectJunction Adapter</td>
<td>1</td>
<td>ES256</td>
</tr>
<tr>
<td></td>
<td>UHPLC Liquid Junction Kit</td>
<td>1</td>
<td>ES269</td>
</tr>
</tbody>
</table>
### Table 6. Contents of the Nanospray Flex Series ion source kits (Sheet 2 of 2)

<table>
<thead>
<tr>
<th>Image</th>
<th>Part</th>
<th>Quantity</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>–</td>
<td>Liquid Junction Column Out Line (tubing), 360 μm OD, 20 μm ID, 550 mm long</td>
<td>1</td>
<td>6041.5290</td>
</tr>
<tr>
<td>–</td>
<td>Liquid Junction Waste In Line (tubing), 360 μm OD, 75 μm ID, 550 mm long</td>
<td>1</td>
<td>6041.5289</td>
</tr>
<tr>
<td>–</td>
<td>Emitter, stainless steel, 150 μm OD, 30 μm ID, 40 mm long (4 pieces)</td>
<td>1</td>
<td>ES542</td>
</tr>
<tr>
<td>–</td>
<td>Emitters, New Objective SilicaTip, uncoated, 360 μm OD, 20 μm ID, 10.5 cm long (5 pieces)</td>
<td>1</td>
<td>FS360-20-10N5-105CT</td>
</tr>
<tr>
<td>–</td>
<td>Emitter sleeves, PEEK, 1/32 in. OD, 280 μm (10 pieces)</td>
<td>1</td>
<td>SC903</td>
</tr>
<tr>
<td>–</td>
<td>Hex key, 3 mm</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td>Spare parts (blind plug, O-rings, screws, sleeves)</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

---

*a* The Nanospray Flex NG source housing comes with the Nanospray Flex NG Ion Source Kit (P/N ES072) and cannot be purchased separately.

*b* The Nanospray Flex source housing comes with the Nanospray Flex Ion Source Kit (P/N ES071) and cannot be purchased separately.

*c* The ion source kit includes either two of the analog cameras (P/N ES216) with one LCD monitor (P/N ES217) or two of the USB cameras with two USB extension cords.

*d* In 2015, the UHPLC kit replaced the Liquid Junction Cross 1/32 (P/N ES257).
Index

A
analysis, offline 2

C
cameras
   DinoCapture video application (USB camera) 10
   focusing wheel 11
   mounting bracket (USB camera) 10
   troubleshooting 41
   type provided 9
   See also procedures
column, configuring one or two 14
compliance
   regulatory xiii
consumables, part numbers 45
contacting us xiv

D
DinoCapture application (USB camera) 12
directive, WEEE iii
DirectJunction adapter
   column configuration 14
   See also procedures
documentation online survey x
documentation, accessing ix
downloading documents x

E
emitters
   borosilicate (offline mode) 32
   setup angle and distance 26
   stainless steel or glass 13
   See also procedures

F
figures, list of vii

G
gas connection, optional 8

H
high voltage
   caution statement 28
   connector, source back 7
   DirectJunction cable 27
   troubleshooting 42

I
ion sources
   compatible mass spectrometers xi
   locking levers, positions 6
   optional gas connection 8
   photo of 3–4, 7
   See also procedures

L
Liquid Junction Cross 1/32 48

M
mass spectrometer
   ion sweep cone, types 6
   NSI mode, configuring 37
   preparing before installing the source 5
   spray cone attached to MS 7

N
nanoelectrospray, advantages 2
NSI, offline flow rate 2
NSI, online flow rate 2
Index: 0

O
offline analysis  2
offline mode  29

P
procedures
cameras, installing  9
DirectJunction adapter, attaching  25
emitters
borosilicate
  installing  33
  opening and positioning the tip  34
glass (HPLC), configuring  19
glass (UHPLC), configuring  20
glass or stainless steel tip position, adjusting  27
offline borosilicate, loading sample  32
stainless steel (HPLC), configuring  16–17
ion source
  attaching to the MS  6
  removing from the MS  8
monitor, installing  9
nanoViper fitting, using  15
nitrogen gas (optional), connecting  8
offline source head, installing  31
offline spray, restarting  35
video picture, adjusting  12

R
regulatory compliance  xiii
replaceable parts  45
resources, additional  23

S
safety
  high voltage  28
  symbol descriptions  xi
signal issues, troubleshooting  41
source
  See ion sources
spray voltage, setting the value  38
symbols, meaning  xi

T
Thermo Scientific website, user documents  x
troubleshooting  10, 41
Tune application, opening  37
Tune Plus (legacy) application, opening  38

U
UHPLC liquid junction cross, mounting  22

W
WEEE directive  iii

X
XYZ manipulator control knobs  28